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1.0 Fundamentals Training  

1.1 Logging In 

An account will be created and log-in information issued to a user as per district policy.  When a 
user initially logs in, they will be prompted to change their password immediately.  Passwords 
are case-sensitive and must be in compliance with the Ministry of Education requirements. 

1. Go to https://www.myeducation.gov.bc.ca/aspen/logon.do 

2. Enter the username provided to you in the Login ID field. 

3. Enter the password provided to you in the Password field.  

 
 

4. Click Log On. 

5. You will be prompted with the following window.  In the Current Password field, enter 

the password issued for your initial login.  In New Password and Confirm New 

Password, enter a new password that observes the requirements indicated in the top 

portion of the pop-up.   

6. Click OK. 

 

https://www.myeducation.gov.bc.ca/aspen/logon.do


 

Fundamentals Training v1.0 Page 6 

2.0 Managing User Preferences 

2.1 Security 

Your access to MyEducation BC will be determined by the security role that is assigned to your 
user account.  This access is assigned by the district as required for the role and duties you 
perform in your role.   

 

2.2 Settings Bar 

The settings bar is the first step in navigating MyEducation BC.  The options available to the 
user here are determined by the security access granted by the district.   Select School, for 
example, will only appear if the user has been assigned to more than one school.   

All users will see Set Preferences and Log Off 

 

 Change View 2.2.1

Change View allows the user to navigate between different levels of the application, if the 
appropriate security access has been given to the user.  The example below is a common 
display for a district level user.   

 

 

To change views: 

1. Click the Change View selection on the settings bar.  

2. Click on the name of the view you wish to work in.  The name of the view you are in will 

be displayed just below the settings bar.  
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 Select School 2.2.2

If the user account has access to more than one school, the Select School option will appear on 
the settings bar menu.  

To select a school: 

1. In the Change View menu, select School 

2. Click the Select School selection on the settings bar.   This will generate a pop-up 

window.  

3. Click the radio button beside the appropriate school.  

4. Click OK.  

 

 Set Preferences 2.2.3

This option on the settings bar allows you to personalize MyEducation BC for your use.  These 
settings are specific to your user account.  There may be more options that in the screenshot 
below, depending on the view you are working in (District view is different from School view).   

2.2.3.1 General 

These settings determine the “look and feel” for MyEducation BC for the individual user.  See 
the table below the screenshot for a definition of each of these fields. 
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Field Description 

Default Locale Click this drop-down to select your language and date preferences when 
using MyEducation BC.  

This selection also affects the display of dates in MyEducation BC. If you 
select:  

English Canada: Dates appear as date/month/year 

French Canada: Dates appear as year/month/date 

US English: Dates appear as month/date/year 

Default View Click this drop-down to select the default view you want you want to see 
when logging on to MyEducation BC, such as the School view. (This option is 
only available if you have access to more than one view.) 

Default School Click the  to select the default school you want to use when accessing the 
School view. (This option is only available if you have access to more than 
one school.) 

Auto-save interval 
(minutes) 

Type the number of minutes you want to lapse before the system 
automatically saves the information you enter on a detail page. The system 
displays a message to the right of the Save and Cancel buttons on detail 
pages, alerting you of the time of the last auto-save, or why the auto-save 
failed. 

Disable User-defined 
Help 

If your district creates and uses user-defined help, and you do not want to 

view the user-defined help icon  for fields and templates, select this 
checkbox. 

Records per page Type the number of rows you prefer on a list page. (Most users like to see all 
rows on a page without having to scroll.) 

Show lower page 
controls 

Page controls will automatically appear at the top of a page where the 
number of records in the list exceeds one page.  To display the page 
controls at the bottom of all list pages, select this checkbox.   

 

Warn on save If you want the system to display a warning when you click Save on a list 
page after you have used the Modify List option, select this checkbox. 
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2.2.3.2 Security 

The Security sub-top tab in Set Preferences records your email address and security question 
and answer.  This information must be populated for the user to be able to use the “Forgot 
Password” function in MyEducation BC.   This area also allows the user to change their 
password at any time.  See the table below the screenshot for a definition of each of these 
fields. 

 

 

Field Description 

Primary email Type your primary email address. The system sends your password to this 
address if you click the 'I forgot my password' link on the logon page. 

Note: This is the address that appears in the From field when using the Send 
Email option. 

Alternate email If you already entered an alternate email address, such as for your Google 
Docs account, that address appears. 

Security question Click this drop-down to select the security question you want to answer if you 
forget your password. 

Security answer Type the security answer. 

Confirm answer Type the security answer again. 

Password Click Change to change your password.  Password requirements can be 
viewed by clicking Click to view. 
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 Log Off 2.2.4

All users should use the Log Off item in the Settings Bar to exit MyEducation BC.  This will 
properly terminate the session and force the entry of a login id and password to re-enter the 
system.    

2.3 Removing Browser Buttons (F11) 

Browser buttons for back and forward and cancel should not be used to navigate the 
application.  In MyEducation BC, it is always best to use the application buttons to close a pop-
up window, go back to a previous screen, exit the application, etc.  

Users can remove the temptation to use the browser buttons by pressing F11 to hide the 
browser menu.  This is a toggle function, so pressing F11 again will cause the browser buttons 
to re-appear when needed. 

 

3.0 Navigation Tools & Selecting Records 

3.1 Top Tabs and Side Tabs 

Top tabs represent functional areas of MyEducation BC.  These are scoped to the user view 
and role, so a user will only see what they have been given to view or work with.  The top tab 
that is highlighted indicates where the user is in the application.  

 

Side tabs provide access to additional details of the top tab functional area. 
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3.2 Sub-side Tabs, Sub-top Tabs and Leaves 

Side tabs usually contain sub-side tabs, leaves and sub-top tabs. 

 

 

Sub-top tabs appear at the top of a list, when a side tab is selected.  A good example of this is 
in the Student top tab > Details side tab.  

 

 

3.3 Page selector 

This navigation tool allows the user to select a range of records, something like a dictionary.   If 
the user has set their preference to display 10 records per page, each selection in the paginator 
will display 10 records.   This tool will appear at the top and bottom of the list if the user has set 
their preference to Show lower page controls. 

A user can use the drop-down arrow to select a page in the list or the back and forth arrows at 
either side to move through the pages consecutively. 
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3.4 Record Navigation Bar 

The Record Navigation Bar can be used to change the record being viewed.  It generally 
appears when the user is in a side-tab where the information displayed is limited to one record.   

For example, if the user is in the Student top tab > Details side tab, only one student is 
displayed.  The user can: 

 Use the  in the record navigation bar to search for a new student without returning 

to the student list.   

 Use the forward and back arrows on the record navigation bar to move to the next 

consecutive record.  

 Use the first and last record buttons to move to the first record in the paginator or to the 

last record in the paginator.  The first and last record buttons do not respond to the user 

Records per page preference.   

 

 

3.5 Ctrl + F 

The Ctrl + F command works on every list in MyEducation BC, including pop-up windows with 
lists.  This will generate a search box where the user can enter the search criteria.  It is 
important to understand that the search will be conducted on the first column of information in 
the field set, or the column of data that represents the primary sort.    

Filters can also affect the search results.  For example, if the filter is set to Primary Active 
Students in the student list, the search will not return results for a student who is a secondary 
student. 

Results will be returned with the closest match the system can make.  The closest match record 
will be selected in the list.     
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3.6 Hyperlinks 

Hyperlinks are in blue lettering which show an underscore when the user hovers over them with 
a mouse.  Clicking on a hyperlink will take the user to the details of that particular record. 

 

3.7 Breadcrumbs 

When a user has selected a record and is viewing the details, a “breadcrumb” trail will appear at 
the top of the list to indicate what is being viewed and the path used to arrive at that location.  

In the example below, the user is viewing an attendance record for February 23, 2015 for the 
student Joleen Adamus in the Attendance top tab > Daily History side tab.  

Breadcrumbs will create a blue hyperlink that the user can click on to return to the full list of 
records.  
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3.8 Checkboxes vs Radio Buttons 

There are many selection lists throughout MyEducation BC.  If a list shows round radio buttons, 
it indicates that only one record can be selected.  If a list shows square checkboxes, then 
multiple records can be selected.  Good examples of this are: 

 Student top tab:  More than one student can be selected at a time because there are 

checkboxes in front of their names.  

 
 

 Student top tab > Options menu > Snapshots:  Only one snapshot can be selected 

because there are radio buttons in front of them.   

 

 

3.9 Clearing Record Selections 

When multiple records have been selected in a list, a user may clear them using one of the 
following options: 

 Manually uncheck the box in front of a record.  This will de-select an individual record.  

 Use the  icon at the top of the list of selected records.  This will clear ALL selections. 

 Changing the filter to generate a new list. 

 Leaving the top tab to navigate to another area of the application.  This is only true if the 

user is on the main list and has not performed an Options > Show Selected on the 

records.   

 Logging out of MyEducation BC. 
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4.0 Icons and Alerts 

MyEducation BC will display a number of icons throughout the application to indicate additional 
information or alert information.  Hovering over these icons will provide a tool tip to let you know 
what type of information the icon contains.  Clicking on the icon will generate additional 
information.  These icons include: 

 Medical and health alerts:  ,  

 Legal alerts:   

 Other alerts:   

 Quick Status for locating a student:  

 Student Services alerts:  ,  

 Informational alerts:    

Information on maintaining student alerts is included in the Enrollment Management and 
Demographics and Student Services documentation.  

5.0 Menu Bar 

The menu bar appears just below the top tabs in MyEducation BC.  The menu headers are the 
same regardless of the top tab the user has selected.  The items displayed in the menu will 
change, depending on the top tab and side tab the user has selected. 

5.1 Options 

The Options menu is an action centre.  This is where a user can initiate actions on the data that 
is displayed on the screen.  In some cases, the list of items may show an arrow, indicating 
additional options.   
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5.2 Reports 

Reports will display a list of reports available in specific areas of the application.  It is important 
to note that reports are associated with top tabs and side tabs and relate to the data displayed 
on page.  For example:  In the Student top tab, clicking on Reports will show a list of several 
reports, and a few report categories, indicated by an arrow, which list additional reports.  
Staying in the Student top tab and clicking on the Transcript side tab will generate a shorter list 
of reports that are related to student transcript information.   
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5.3 Help 

Several Help options are available through Help on the menu bar as well.  It is important to note 

that these tools are not yet customized for MyEducation BC and may reference options or 

functions that are not available to District and School Users.  However, it is still useful for many 

basic functions.   

 
 

The About MyEducation BC item will provide information about the server to which your session 

is connected.  This will display below the copyright information and can be useful information for 

the service desk if users are experiencing problems with performance or report running in 

MyEducation BC.  Example:  vaspnapprd3 indicates that the user is on server 3.  

 

 On-line help 5.3.1

On-line help opens in a new window and provides a variety of ways to search for information.  
The on-line help function will respond to the screen you are viewing when you enter the on-line 
help.  For example, if you are on the Student top tab, topics on student information will display.  
If you change to the Attendance top tab and enter the on-line help, topics related to attendance 
will be displayed.   
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 Release Notes 5.3.2

Release notes will provide information about the lastest changes to the software product.  
These release notes will not include additional enhancements and configuration changes made 
to MyEducation BC specifically.  These items are currently posted to the ISW.   

 User Guides 5.3.3

User guides open up as documents with hyperlinks in the table of contents.  These guides can 
be very helpful for some areas of the application as a reminder of how to perform certain 
functions.  Remember that they are not customized for MyEducation BC and the custom guides 
posted on the ISW should be used wherever possible, as they represent the customized 
functionality of MyEducation BC.   

 Quick Reference Cards 5.3.4

Quick reference cards are short, task-specific reference documents.  These can be very useful 
for end users as reminders for specific tasks without generating a large document. 

 Videos & Training Tools 5.3.5

This area of the Help menu provides categories of training tools which contain Lesson Plans, 
Quick Reference Guides and Videos.  Clicking on a category will display all of the options within 
that category.   The quick reference guides within these toolkits are different from the quick 
reference cards.  The quick reference guides are task-specific, but are often more than 2 pages.    

 

   

 

5.4 Menu Bar Tools 

The menu bar provides several tools for filtering, displaying, sorting and exporting data in 
MyEducation BC.  The options that display when using these tools depend on the top tab and 
side tabs of the application.   

These tools are described below.   
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 Filters  5.4.1

Filters provide the user with the ability to group records in a list.  Filters are connected to 
queries, so they are dynamic – every time a user selects a filter, it will display all of the latest 
information in that group of records.  Users have the ability to hide filters that are not useful to 
them and to change the order in which the filters display in the filter list.     

Users also have the ability to create their own filters.    

  

The filters that appear in the list already have been created at the Enterprise level or by district 
users who may have created filters for their own schools.  

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, users may see the following in brackets beside 

the name of the filters: 

a. System:  these filters are part of the core application.  They can be hidden or 

moved up or down in the list, but cannot be modified. 

b. Enterprise:  these filters have been created at the enterprise level and appear 

for all districts and schools.  They can be hidden or moved up or down in the list, 

but cannot be modified. 

c. District:  these filters have been created at the district level for the district level 

views. They can be hidden or moved up or down in the list, but cannot be 

modified unless you have access to the District view. 

d. School:  these filters have been created either by a school user, or been created 

by a district user in the school view.  They will be visible to all users who have 

access to the School view.  These filters can only be modified or deleted by a 

school user or a district user with school view access. 

e. User:  these filters have been created by an individual user.  They will only show 

in the list for the user who created them and therefore can only be modified or 

deleted by the user who created them.  
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5.4.1.1 To Move a Filter 

A user can choose to have the filter they use the most be the default in that screen by moving it 
to the top of the list. 

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, click on the name of the filter to be moved.  It will 

be highlighted.  

3. Click the   or  buttons to position the filter in the list.  Any filter placed at the 

very top of the list will become the default filter when entering the screen. 

4. Several filters can be moved at once by using Shift + click and using the  or  

buttons.   

5. Click Close. 

5.4.1.2 To Hide a Filter 

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, click on the name of the filter to be hidden.  It will 

be highlighted.  

3. Click the  button.  If the Show All box is checked, the filter will still appear 

here, but is now greyed out.  This means the filter will no longer appear in the list when 

the  icon is clicked.  The item can be restored at any time by clicking the  

button to put it back in the list.   If the Show All box is not checked, the filters which have 

been hidden will no longer be visible.  This checkbox will need to be enabled in order to 

restore a hidden filter. 

4. Click Close. 

5.4.1.3 To Create a New Filter 

Filters are connected to queries and snapshots.  Users can access those queries and create 
them as a filter by using the New button in the Manage Filters window. 

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, click the  button. A list of available queries will 

appear.   

a. Filter Type:  This allows a filter to be created from an existing query or snapshot.  

Changing this selection will change the list of options below.   

b. Owner:  Who will see and use this filter?  If the user has district or school 

access, they will have the ability to set this filter for all users with those views.  If 

the user sees no other selection, they are creating a User filter. 

c. Name:  Give the filter a name that makes sense for its function.   

d. Click the radio button beside the query or snapshot in the list that the filter will be 

based on.   

e. Click OK. 
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f. The filter will now appear in the Manage Filters window and in the list below the 

 icon for this screen. 

3. Click Close on the Manage Filters window. 

5.4.1.4 To Edit a Filter 

A user can only edit a filter that exists at the level of their user role view.  In other words, a 
district user who has access to both district and school views can edit a District or School filter.  
A school user can edit a School filter because they have school view access.  A user that only 
has staff view will only be able to edit their own User filters. 

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, click the   button. 

3. In the pop-up window: 

a. Filter Type:  This allows a filter to be changed from its current query or snapshot, 

to a new query or snapshot.  Changing this selection will change the list of 

options below.   

b. Owner:  Who will see and use this filter?  If the user has district or school 

access, they will have the ability to set this filter for all users with those views.  If 

the user sees no other selection, they are creating a User filter. 

c. Name:  Give the filter a name that makes sense for its function. 

4. Click OK. 

5. Click Close on the Manage Filters window. 

 

5.4.1.5 To Copy a Filter 

Because a filter is connected to a query or a snapshot, there are not too many reasons to copy 
a filter.  A user may decide to copy a filter in order to rename it to something that is more 
meaningful.  

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, click the   button. 

3. In the pop-up window: 

a. Name:  Give the filter a name that makes sense for its function. 

b. Owner:  Who will see and use this filter?  If the user has district or school 

access, they will have the ability to set this filter for all users with those views.  If 

the user sees no other selection, they are creating a User filter. 

4. Click Save.  

5. Click Close on the Manage Filters window. 

If a filter has been copied, the user may want to consider hiding or deleting the original to avoid 
confusion. 
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5.4.1.6 Deleting a Filter 

A user can only delete a filter that exists at the level of their user role view.  In other words, a 
district user who has access to both district and school views can delete a District or School 
filter.  A school user can delete a School filter because they have school view access.  A user 
that only has staff view will only be able to delete their own User filters. 

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, click on the name of the filter to be deleted.  It will 

be highlighted.  

3. Click the  button.   

4. Click Close on the Manage Filters window. 

Deleting a filter does not delete the query behind it.  If a filter is deleted in error, it can be 
restored by using the Add button.   

 Field Sets   5.4.2

Field sets simply display information in a list.  By selecting a different field set, the user is 
choosing to display different columns of information for the same records in the list.  Field sets 
can be very useful for creating commonly used sets of information and then extracting those into 
a spreadsheet for analysis or manipulation.  

The field sets that appear in the list already have been created at the Enterprise level or by 
district users who may have created field sets for their own schools.  

1. Click the  icon and select Manage Field Sets . . .  

2. In the Manage Field Sets pop-up window, users may see the following in brackets 

beside the name of the field sets: 

a. System:  these field sets are part of the core application.  They can be hidden or 

moved up or down in the list, but cannot be modified. 

b. Enterprise:  these field sets have been created at the enterprise level and 

appear for all districts and schools.  They can be hidden or moved up or down in 

the list, but cannot be modified. 

c. District:  these field sets have been created at the district level for the district 

level views. They can be hidden or moved up or down in the list, but cannot be 

modified unless you have access to the District view. 

d. School:  these field sets have been created either by a school user, or been 

created by a district user in the school view.  They will be visible to all users who 

have access to the School view.  These field sets can only be modified or deleted 

by a school user or a district user with school view access. 
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5.4.2.1 To Move a Field set 

A user can choose to have the field set they use the most be the default in that screen by 
moving it to the top of the list. 

1. Click the  icon and select Manage Field Sets . . .  

2. In the Manage Field Sets pop-up window, click on the name of the field set to be moved.  

It will be highlighted.  

3. Click the   or  buttons to position the field set in the list.  Any field set placed at 

the very top of the list will become the default field set when entering the screen. 

4. Several field sets can be moved at once by using Shift + click and using the  or 

 buttons.   

5. Click Close. 

5.4.2.2 To Hide a Field Set 

1. Click the  icon and select Manage Field Sets . . .  

2. In the Manage Field Sets pop-up window, click on the name of the field set to be hidden.  

It will be highlighted.  

3. Click the  button.  If the Show All box is checked, the field set will still 

appear here, but is now greyed out.  This means the field set will no longer appear in the 

list when the  icon is clicked.  The item can be restored at any time by clicking the 

 button to put it back in the list.   If the Show All box is not checked, the field 

sets which have been hidden will no longer be visible.  This checkbox will need to be 

enabled in order to restore a hidden field set. 

4. Click Close. 

5.4.2.3 To Create a New Field Set 

1. Click the  icon and select Manage Field Sets . . .  

2. In the Manage Field Sets pop-up window, click the  button. 

3. In the pop-up window: 

a. Name:  Give the field set a name that makes sense for its data set. 

b. Owner:  Who will see and use this field set?  If the user has district or school 

access, they will have the ability to set this field set for all users with those views.  

If the user sees no other selection, they are creating a User field set. 

c. In the Available Fields window, use the drop-down menu to select the table you 

want to pull data fields from.   These are listed in the order most frequently used.  

If the user is having trouble finding a field, use the  button to sort them 

into alphabetical order.   

d. Click on the field you want to select so it is highlighted in the list.  Click the 

 button.  This will move the field into the Selected Fields window.   
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Note:  Multiple fields from multiple tables can be selected or the same field set.   

4. Once all fields have been selected, click Save.  

5. Click Close on the Manage Field Sets window.  The field set will now appear in the list 

for selection.   

5.4.2.4 To Edit a Field set 

A user can only edit a field set that exists at the level of their user role view.  In other words, a 
district user who has access to both district and school views can edit a District or School field 
set.  A school user can edit a School field set because they have school view access.  A user 
that only has staff view will only be able to edit their own User field sets. 

1. Click the  icon and select Manage Field Sets . . .  

2. In the Manage Field Sets pop-up window, click on the name of the field set to be edited.  

It will be highlighted. 

3. Click the   button. 

4. In the pop-up window: 

a. Name:  Enter the new name for the field set, if appropriate. 

b. Owner:  Who will see and use this field set?  If the user has district or school 

access, they will have the ability to set this field set for all users with those views.  

If the user sees no other selection, they are creating a User field set. 

5. In the Available Fields window, click the fields of information you want to add to the field 

set.  Click the  button.  Alternatively, in the Selected Fields window, click the fields 

of information you want to remove from the field set.  Click the  button. 

6. Click Save. 

7. Click Close on the Manage Field sets window. 

5.4.2.5 To Copy a Field set 

A user may see a field set in the list that suits their needs, but wants to add or remove some 
information from it.  If the user does not own the field set, a copy can be made and adjusted to 
suit the need.  

1. Click the  icon and select Manage Field Sets . . .  

2. In the Manage Field Sets pop-up window, click on the name of the field set to be copied.  

It will be highlighted. 

3. Click the   button. 

4. In the pop-up window: 

a. Name:  Give the field set a name that makes sense for its data set. 

b. Owner:  Who will see and use this field set?  If the user has district or school 

access, they will have the ability to set this field set for all users with those views.  

If the user sees no other selection, they are creating a User field set. 

5. Click Save.  

6. Click Close on the Manage Field sets window. 
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If a field set has been copied, the user may want to consider hiding or deleting the original to 
avoid confusion. 

5.4.2.6 Deleting a Field Set 

A user can only delete a field set that exists at the level of their user role view.  In other words, a 
district user who has access to both district and school views can delete a District or School 
field set.  A school user can delete a School field set because they have school view access.  A 
user that only has staff view will only be able to delete their own User field sets. 

5. Click the  icon and select Manage Field Sets . . .  

6. In the Manage Field Sets pop-up window, click on the name of the field set to be 

deleted.  It will be highlighted.  

7. Click the  button.   

8. Click Close on the Manage Field Sets window.  

 Sorts   5.4.3

There are different ways to sort data in a field set, which are defined below.  The options for 
sorting data in a field set are: 

 Click the header of a column of data.  The field set sorts by the data in that column, 

opposite to its original sort order. Clicking the header again sorts the data back to its 

order.  This function can be used for multi-level sorts of up to 3 columns of data at a 

time.  For example:  clicking the Gender column in the Student top tab, then clicking the 

Pupil # column, then the Grade column, the grade would be the primary sort.  Data 

displayed will be in order by Grade, then by Pupil #, then by Gender. 

 Use the  icon, which simply sorts the data in the field set by the list value chosen for 

the sort.  The sort icon can also be used to set any sort back to the default.   

The field sets that appear in the list already have been created at the Enterprise level or by 
district users who may have created field sets for their own schools.  

1. Click the  icon and select Manage Sort Orders. . .  

2. In the Manage Sort Orders pop-up window, you may see the following in brackets beside 

the name of the field sets: 

a. System:  these sort orders are part of the core application.  They can be hidden 

or moved up or down in the list, but cannot be modified. 

b. Enterprise:  these sort orders have been created at the enterprise level and 

appear for all districts and schools.  They can be hidden or moved up or down in 

the list, but cannot be modified. 

c. District:  these sort orders have been created at the district level for the district 

level views. They can be hidden or moved up or down in the list, but cannot be 

modified unless you have access to the District view. 
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d. School:  these sort orders have been created either by a school user, or been 

created by a district user in the school view.  They will be visible to all users who 

have access to the School view.  These sort orders can only be modified or 

deleted by a school user or a district user with school view access. 

5.4.3.1 Move a sort order 

A user can choose to have the sort order they use the most be the default in that screen by 
moving it to the top of the list. Users can also create custom sorts.   

A user can choose to have the field set they use the most be the default in that screen by 
moving it to the top of the list. 

1. Click the  icon and select Manage Sort Orders . . .  

2. In the Manage Sort Orders pop-up window, click on the name of the sort order to be 

moved.  It will be highlighted.  

3. Click the   or  buttons to position the field set in the list.  Any sort order placed 

at the very top of the list will become the default sort order when entering the screen. 

4. Several sort orders can be moved at once by using Shift + click and using the  or 

 buttons.   

5. Click Close. 

5.4.3.2 To Hide a Sort Order 

1. Click the  icon and select Manage Sort orders . . .  

2. In the Manage Sort orders pop-up window, click on the name of the sort order to be 

hidden.  It will be highlighted.  

3. Click the  button.  If the Show All box is checked, the sort order will still 

appear here, but is now greyed out.  This means the sort order will no longer appear in 

the list when the  icon is clicked.  The item can be restored at any time by clicking 

the  button to put it back in the list.   If the Show All box is not checked, the 

sort orders which have been hidden will no longer be visible.  This checkbox will need to 

be enabled in order to restore a hidden sort order. 

4. Click Close. 

5.4.3.3 To Create a New Sort Order 

1. Click the  icon and select Manage Sort Orders . . .  

2. In the Manage Sort Orders pop-up window, click the  button. 

3. In the pop-up window: 

a. Name:  Give the sort a name that makes sense for its function. 
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b. Owner:  Who will see and use this sort?  If the user has district or school access, 

they will have the ability to set this sort for all users with those views.  If the user 

sees no other selection, they are creating a User sort. 

c. In the Available Fields window, use the drop-down menu to select the table you 

want to sort fields from.   These are listed in the order most frequently used.  If 

the user is having trouble finding a field, use the  button to sort them into 

alphabetical order.   

d. Click on the field you want to select so it is highlighted in the list.  Click the 

 button.  This will move the field into the Selected Fields window.   

Note:  Multiple fields from multiple tables can be selected or the same field set.   

4. Once all fields have been selected, click Save.  

5. Use the  and  buttons to arrange the fields in the order you want them to sort.  

The  button will cause (desc) to appear beside the field highlighted when you 

click the button.  This means the data in that field will be sorted in reverse order when 

this new sort is applied to a field set. 

6. Click Close on the Manage Sort Orders window.  The sort order will now appear in the 

list for selection.   

5.4.3.4 To Edit a Sort Order 

A user can only edit a sort order that exists at the level of their user role view.  In other words, a 
district user who has access to both district and school views can edit a District or School sort 
order.  A school user can edit a School sort order because they have school view access.  A 
user that only has staff view will only be able to edit their own User sort orders. 

1. Click the  icon and select Manage Sort Orders . . .  

2. In the Manage Sort Orders pop-up window, click on the name of the sort order to be 

edited.  It will be highlighted. 

3. Click the   button. 

4. In the pop-up window: 

a. Name:  Enter the new name for the sort order, if appropriate. 

b. Owner:  Who will see and use this sort order?  If the user has district or school 

access, they will have the ability to set this sort order for all users with those 

views.  If the user sees no other selection, they are creating a User sort order. 

5. In the Available Fields window, click the fields of information you want to add to the sort 

order.  Click the  button.  Alternatively, in the Selected Fields window, click the 

fields of information you want to remove from the sort order.  Click the  

button. 

6. Click Save. 

7. Click Close on the Manage Sort Orders window. 
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5.4.3.5 To Copy a Sort Order 

A user may see a sort order in the list that suits their needs, but wants to add or remove some 
information from it.  If the user does not own the sort order, a copy can be made and adjusted to 
suit the need.  

1. Click the  icon and select Manage Sort orders . . .  

2. In the Manage Sort orders pop-up window, click on the name of the sort order to be 

copied.  It will be highlighted. 

3. Click the   button. 

4. In the pop-up window: 

a. Name:  Give the sort order a name that makes sense for its data set. 

b. Owner:  Who will see and use this sort order?  If the user has district or school 

access, they will have the ability to set this sort order for all users with those 

views.  If the user sees no other selection, they are creating a User sort order. 

5. Click Save.  

6. Click Close on the Manage Sort Orders window. 

If a sort order has been copied, the user may want to consider hiding or deleting the original to 
avoid confusion. 

5.4.3.6 Deleting a Sort order 

A user can only delete a sort order that exists at the level of their user role view.  In other words, 
a district user who has access to both district and school views can delete a District or School 
sort order.  A school user can delete a School sort order because they have school view 
access.  A user that only has staff view will only be able to delete their own User sort orders. 

1. Click the  icon and select Manage Sort Orders . . .  

2. In the Manage Sort Orders pop-up window, click on the name of the sort order to be 

deleted.  It will be highlighted.  

3. Click the  button.   

4. Click Close on the Manage Sort Orders window.  

 Quick Charts   5.4.4

Charts provide an organized way to visually represent data. The Quick Chart feature enables 
the user to create bar, line, and pie charts from any standard list page. These charts can be 
saved for future use.  Users with privileges to manage school and/or district resources can 
create charts to share school- and district-wide.  

Click the  icon to access the following options:  

 Create Quick Chart: Brings up the Quick Chart Wizard, which allows the user to 

customize many different areas of the resulting chart. 

 Bar Chart: Brings up a streamlined Quick Chart screen, which requests only minimal 

information required to create the bar chart. 
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 Line Chart: Brings up a streamlined Quick Chart screen, which requests only minimal 

information required to create the line chart. 

 Pie Chart: Brings up a streamlined Quick Chart screen, which requests only minimal 

information required to create the pie chart. 

5.4.4.1 To Create a Quick Chart: 

1. Click the  icon and select Create Quick Chart to open the Quick Chart wizard, or 

select Quick Chart from the Reports menu.  The Create Quick Chart wizard appears: 

 

2. Step 1: Source.   

a. Select New report. 

b. Click Next.   

3. Step 2: Report Type 

a. Click the Report Type drop-down to select one of the following: 

i. Quick Chart—Bar 

ii. Quick Chart—Line 

iii. Quick Chart—Pie 

4. Click the Format drop-down to select the format for the chart.  Select one of the 

following: 

a. Standard 

b. Enhanced  
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5. Step 3: Field Selection.   

a. In the Categories (Horizontal Axis) box, click the  icon at Group by 

field and make a selection. The user can choose from the tables and fields that 

are related to the records in the current list. The Categories (Horizontal 

Axis) box, sometimes called the independent variable, sets the data to measure. 

If the choice is a Numeric, Date or Time field, additional options appear to further 

organize the data which will be displayed on the chart.  
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b. For bar and line charts, a Series (Legend Entries) box is available. Click the  

icon at the Group by field and make a selection. Series groups appear in a 

legend to the right of the chart and provide a color-coded guide to data shown in 

the chart. 

Note: Bar and line charts do not require both a category and series to be selected. Charts that 
exclude a category will not have x-axis labels. Charts that exclude a series will not include a 
legend. 

6. The Interval drop-down menu for numeric has the following options: 

a. Chart each value separately: Each numeric value gets its own data point. 

b. Interval group: The Interval field groups the results according to the number 

entered in the Interval group size field. For example, if you want the group Year 

of Graduation to display in the chart in pairs, you would enter 2 in this field.  

The Interval group size appears.  The value in this field sets the number of data 

points that get combined into a single category. 

c. Interval group summations.  The Interval group size appears. The value in 

this field sets the number of data points that get combined into a single category. 

d. Total summation: Sums the values of the Group by field. 

7. If the list of data being charted contains trivial cases which should be excluded from the 

chart, the option Group trivial results as "Other” is provided. Select this checkbox if 

the users wants to group all data points of less than a certain percent together into a 

single point called Other.  For example, if the user is only concerned with viewing the 

most common conduct codes, select this option and enter a value of 5% in the Less 

than % field. This will group all codes which total less than 5% of the total data into a 

single Other group. 

Note: This option can only be used in the Categories or Series, not both.  

8. Click Next to continue the wizard and set chart options. 

9. Click Finish to create the chart.  

Note:  You can click Finish at any point in the wizard.  New charts use the default format 

options if you click Finish at any point before the final step in the wizard.   

5.4.4.2 To Use a Saved Quick Chart 

1. Click the  icon and select Create Quick Chart to open the Quick Chart wizard, or 

select Quick Chart from the Reports menu.  The Create Quick Chart wizard appears: 
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2. Step 1: Source.  Click Saved report.  A table of saved Quick Charts appears in the 

dialog box. Select the Quick Chart you want to view or edit. 

3. Click Next to continue editing, or click Finish to show the chart. 

 Quick Print   5.4.5

Users can generate a Quick Print using the  icon in the menu bar on any list page.  

5.4.5.1 To generate a Quick Print using the Quick Print icon: 

1. Go to the list page containing the type of data to be reported on. 

2. Select the records you want to include on the report. 

3. In the Options menu, click Show Selected, if you have manually selected records in a 

large list.  Users can also use a filter or query to isolate the records to report on. 

Quick Prints include any records that appear on the current list. 

4. Click the Quick Print icon  in the menu bar.  

 
5. Select one of the format options. 

a. Web Page (HTML): to view the information in an HTML file. 

b. CSV: to view the information in a text file that separates each field with a comma. 

If saved, the file will have a .CSV extension 

c. TXT: to view the information in a text file that separates each field with a comma. 

If saved, the file will have a .TXT extension. 



 

Fundamentals Training v1.0 Page 33 

Note: The two comma-separated values formats (CSV and TXT) create identical 

files; the only difference is the file extension. Some Web browsers only handle 

one extension properly. 

d. Microsoft Word (DOC): to view the information in a Word document. 

6. Different browsers handle quick prints in different ways.  Users may need to change 

browser settings to allow downloads, or use shortcut keys such as Ctrl + S to save the 

data prior to opening it. 

 Maximize  & Minimize   5.4.6

Users can click on these icons to hide top tabs to allow more records per page to be 

visible or to return top tabs to their view. 

6.0 Snapshots 

A snapshot is different from a filter.  Where a filter is dynamic and always returns the latest data, 
snapshot is a static list.  It always displays the same records unless it is manually edited.  Only 
the user who created the snapshot can add or remove students from it. 

6.1 Creating and Deleting Snapshots 

 Creating a Snapshot 6.1.1

1. In the School view, click the Student top tab.  Select the records to be included in the 
snapshot.  

2. In the Options menu, click Show Selected, if you have manually selected records in a 

large list.  Users can also use a filter or query to isolate the records to report on. 

Snapshots will include any records that appear on the current list. 

3. In the Options menu, select Snapshots.  

4. In the pop-up window, click the New button. 

a. Name:  Give the snapshot a name that represents the data in the snapshot. 

b. Owner:  Who will see and use this snapshot?  If the user has district or school 

access, they will have the ability to set this for all users with those views.  If the 

user sees no other selection, they are creating a user snapshot. 

c. Save as filter:  If this is selected, the snapshot will appear in the filter menu 

under the  icon. 

d. Move to the top of my list:  If this is selected the snapshot will appear as the 
first item in the filter menu and will become the default filter for that screen. 

5. In the Records to Include box, select one of the following: 

a. Current List:  includes records selected on the list page.  
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b. Snapshot Combination:  this will combine two existing snapshots and is only 
available if two or more snapshots have already been defined.  This provides 3 
options:   

i. Union:  Any records that appear in the first snapshot selected or the 
second snapshot select. For example, if you want to create a snapshot of 
students who are in grade 12 that have a program of study, select Union. 

ii. Intersection:  Only records that appear in both the first and 
second snapshots selected. For example, if you want to create 
a snapshot of students who are both in grade 12 and have a program of 
study, select Intersection. 

iii. Difference:  Any record that appears in the first snapshot you select, but 
not in the second. For example, if you want to create a snapshot of 
students who are in grade 12 but do not have a program of study, select 
Difference. 

6. Click Save.  

 Removing a Snapshot from the Filter Menu 6.1.2

If a snapshot was saved as a filter in error, or is no longer needed as a filter, it can be removed 
from the filter menu.   

1. Click on the  icon and select Manage Filters. 

2. In the Manage Filters window, click on the snapshot so it is highlighted. 

3. Click the Delete button.   

4. Click Close.  

Note:  Deleting the filter does not delete the snapshot behind it.  The filter can be restored 
by creating a new filter and selecting the snapshot.   

 

 Deleting a Snapshot 6.1.3

If a snapshot has become obsolete, it can be deleted from the snapshot menu.   

1. In the Options menu, select Snapshots.  

2. Select the snapshot to be deleted.  

3. Click Delete.  Note that it warns you that you will be deleting any filter associated with 

the snapshot.   

4. Click OK.     
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6.2 Add a Snapshot to a Student 

Snapshots are static lists and will not update automatically when a new student meets the 
criteria the snapshot was based on.   

 To add a snapshot to a student: 6.2.1

1. In the Student top tab, select the student to be included in the snapshot. 

2. Click the Snapshots side tab.  

3. In the Options menu, select Add. 

4. Select the snapshot from the list.  

5. Click OK. 

 

6.3 Removing a Snapshot from a Student 

If a student no longer meets the criteria for the snapshot, a user may want to delete them from 
that snapshot.  

 To remove a snapshot from a student. 6.3.1

1. In the Options menu, select Snapshots. 

2. Select the snapshot to be modified.  Click Use.  The list of students in the snapshot will 

appear.   

3. Check the box beside the student to be removed from the snapshot. 

4. Click the Snapshots side tab.  

5. In the Options menu, select Delete. 

6. Click OK. 

7.0 Queries 

A query is a dynamic filter.  A query performs a new search and displays current information 
each time it is run.  For example, the list of students assigned to a homeroom may be different 
today than it was yesterday because a new student enrolled and was assigned to the 
homeroom. 
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7.1 Creating a Simple Query 

1. In the Options menu, select Query.  

2. In the New Query window, use the following table to select appropriate fields: 

 

Fields Descriptions 

Tables Select the table to search information in. The selected table determines the selections in the 
Fields area. 

For example, if you select the Student table, fields in the student details appear. 

Fields At Fields, select the field to be included in the search criteria. 

Note: Fields within each reference table are listed from most commonly used to least 

commonly used. To change this order to alphabetical, click the Alpha Sort button  

Operator Select an appropriate operator. 

For example, if you are searching for students with a specific year of graduation, select Year 
of graduation in the Fields box, and select the Equals operator. 

Value Enter the search value.  In some cases, this may be a pick list or drop down menu. 

 

3. Click Add to add the criteria to the Search criteria box.  To add other criteria, select 

the Table, Field, and Operator, and enter the Value, if appropriate. 

4. Click And or Or to determine if the students should meet the first criteria, the second 

criteria, or both to be included in the search. 

5. Confirm the correct search criteria are displayed in the Search criteria box.  To delete 

the criteria from this search, highlight it in the Search criteria box and click Delete. 
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6. In the Search based on field, use the drop-down to select which students should be 

included in the search.   

 

 
 

7. Click the Search button to execute the search.  

Once a query has been executed, the records matching the search criteria will be displayed on 
the screen.   The upper right corner of the screen, above the list, will indicate that the records 

displayed are a custom selection.  Use the  icon to return the list to all records or another 
selection.  

7.2 Saving a Query 

If you have created a query that you expect to use frequently, it can be saved for future use. 

1. Create query using instructions for Creating a Simple Query until all the search criteria 

are selected.   

2. Click Save as. . .  The Save as dialogue box appears.   

a. Name:  give the query a name that will make sense.  If it will be saved as a filter, 

keep the name a reasonable length.   

b. Owner type:  Click the drop-down to select one of the following: 

 User: to give a user or yourself access to the query 

 School: to give users at a school access to the query.  User must have 

access to the school view to use this option.  
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 District: to give all users in a district access to the query.  User must have 

access to the district view to use this option. 

c. Owner Name:  click the magnifying glass to change the owner of the query.  The 

owner can edit a saved query.  

d. Save as filter:  Select this checkbox to have this query automatically appear on 

the  menu for all users who have access to it.  If this checkbox is selected, the 

next three fields are accessible.   

e. Filter Owner type:  Click the drop-down to select the owner type as appropriate.  

These options are defined the same as the Query Owner Type options. 

f. Filter Owner name:  click the magnifying glass to change the owner of the 

query.  The owner can edit a saved filter.  

g. Move to the top of my list:  Checking this box will place the query at the top of 

the  menu.  If a query is first on the filter menu, it becomes the default filter for 

that screen.   

3. Click Save. 

7.3 Editing a Query 

Users must have the appropriate permissions to edit the query.   

1. In the Options menu, select Query.  

2. In the New Query pop-up window, click the Select button.  A list will pop up with all the 

queries.  

3. Click the radio button beside the query to be edited.   

4. Click Edit.  

5. Adjust the Name and Owner fields, if necessary.  

6. Click Save. 

7. Ensure your query is still selected and click Use. 

8. Adjust search criteria as necessary.  

9. Click Save. 

7.4 Copying a Query 

Users can copy a query if it contains most of the elements they want, but adjustments are 
necessary. 

1. In the Options menu, select Query.  

2. In the New Query pop-up window, click the Select button.  A list will pop up with all the 

queries.  

3. Click the radio button beside the query to be copied.   

4. Click Copy.  

5. Give the new query a Name and Owner type.  

6. Click Save. 
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7. Ensure your query is still selected and click Use. 

8. Adjust search criteria as necessary.  

9. Click Save. 

7.5 Delete a Query 

If a query has become obsolete, it can be deleted  

1. In the Options menu, select Query.  

2. In the New Query pop-up window, click the Select button.  A list of queries will pop up.  

3. Click the radio button beside the query to be deleted.   

4. Click Delete.  

5. Click Cancel to close the query list popup.   

6. Click Cancel to close the New Query window. 

8.0 Creating a Simple Quick Report 

Quick Reports provide an opportunity for a user to create a customized report that contains 
specific data elements.   For the example below, this is done from the Student top tab, but quick 
reports can be created in different areas of the application with elements that are relevant to the 
chosen area of the application.   

1. In the School view, click the Student top tab 

2. Click the Reports menu item and select Quick Report 

3. In Step 1 of the Wizard, select New Report.  Click Next. 

 

 

4. In Step 2 of the wizard, select Simple.  Click Next.  

5. In Step 3 of the wizard, click the Sort A-Z button to sort the fields in the Student table in 

alphabetical order.  The Selected Fields box will automatically contain the data fields 

from the field set displayed on the screen when entering the quick report function.   

6. Select the desired fields and click the Add >> button to move it to the Selected Fields 

box.  The drop-down menu can be changed from the Student table to a different table to 

combine data elements from other areas of the application.  
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7. In the Selected Fields box, click on any fields you do not need and click the Remove 

button.   

 
 

8. Click Next. 

9. In step 4 of the wizard, select the field(s) you want to sort by in the Available Fields list 

and use the Add button to move them to the Selected Fields box.   The primary sort will 

be the first field in the Selected Fields box, the secondary sort will be the second field, 

etc.  

 
 

10. Click Next. 

11. Step 5 of the wizard is optional.  If you wish to count the records, use these functions to 

do so.   

12. Click Next. 
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13. In Step 6 of the wizard: 

a. Report Title:  Enter a title that makes sense for this report.    

b. Print date:  If selected, the date the report was generated will appear on the 

report.  

c. Body > Format:  Select the format for the report. 

d. Body > Font Face:  Select the font for the report.   

e. Body > Font Size:  Select the font size for the report.   

f. Body > Grid lines:  Select whether the report should have grid lines for 

horizontal, vertical, or both, or none. 

g. Shade alternate lines:  If selected, the data will appear with grey shading on 

alternate lines.   

 
 

14. Click Next. 

15. Step 7 of the wizard is optional.  It allows the user to rename the fields that will appear 

on the report.  To adjust the name of a field, select it from the Field drop-down.  In the 

Title field, give it a name that makes sense.  Note that the field is only being re-named 

for the report – not for the application.    

16. Click Next. 

17. In Step 8 of the wizard, the report may be saved for future use.  To save this quick 

report, click the Save As radio button.   

18. In the activated Name field, type a name for the saved report.  A school user will likely 

be able to set the Owner type to School so the report is available to other users in the 

school.   
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19. Click Finish. 

 

 


